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Introduccion

El objetivo de este curso es adentrarse en las técnicas de disefio y fabricacién de placas de circuito
impreso. Se trata de, a partir de un esquema eléctrico, llevar a cabo el disefio de la placa de
circuito impreso. La placa debe ser fabricable en este caso a una y a dos caras. El proceso termina
con la seleccién de los componentes y el calculo del coste de los mismos.

Este curso esta pensado para ser llevado a cabo sin presencia fisica en el laboratorio, pero no por
ello se renuncia a que el alumno sea capaz de poner en funcionamiento real un circuito
electrénico. Para llevarlo a cabo se plantean varias opciones. La que se considera por defecto en
este manual es la de que el alumno envie su disefio a fabrica para su posterior entrega como
resultado de las practicas. No obstante, también se le ofrece la posibilidad de que se acerque
excepcionalmente al laboratorio para fabricar la placa y probarla o que la pueda realizar por sus

propios medios.

Conviene sefialar que no estamos en un curso de disefio del circuito electrdnico, sino que ya se
parte de un disefio vélido. No se incluyen por tanto aspectos de célculo y/o simulacién.

Es importante tener en cuenta de que no se esta presentando un manual de utilizacién de Eagle ni
un curso de disefio y fabricacion de PCB. Se trata de la parte practica de una asignatura concreta,
para la cual se han priorizado una serie de objetivos de aprendizaje. Su extensién debe ajustarse a
los 3 créditos asignados a estas practicas por lo que se ha tenido que prescindir de aspectos que
pueden ser considerados relevantes. El desarrollo también se corresponde con las mencionadas
circunstancias; se comienza con exposiciones muy detalladas del uso de las herramientas, detalle
que se va perdiendo progresivamente para que sea el alumno el que busque algunas de las
herramientas o soluciones que se mencionan.
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Practica 1: Disefio manual.

Practica 1 : Diseiio manual.

A pesar de que el trabajo de disenar placas de circuito impreso se realiza habitualmente de una
forma enteramente automatizada, vamos a realizar una introduccion al disefio manual tradicional
con el fin principal de adquirir un conocimiento de los problemas asociados a la resolucidn del
layout de la placa. Como objetivo secundario fijaremos el de disponer de una solucidn propia
ajustada a unas reglas de disefio muy estrictas que nos permitan la fabricaciéon de la placa con
medios muy limitados.

Esquema eléctrico propuesto.
En este curso vamos a tratar de construir la placa de circuito impreso correspondiente al circuito

de la Figura 1.1
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Figura 1.1

Se trata de un generador de formas de onda a cuya salida obtendremos una sefal triangular y una
sefial cuadrada. Mediante sendos potencidmetros podremos modificar dindmicamente sus
amplitudes y frecuencias.

Huellas de los componentes.

Para poder realizar un disefo de la placa de circuito impreso debemos conocer las huellas, esto es,
el nimero de puntos de soldadura, su forma y distancia, de cada uno de los componentes. En la
Figura 1.2 podemos ver las huellas de aquellos que van a condicionar nuestro disefio.
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Figura 1.2

Las acotaciones se encuentran en milimetros. Se trata de valores decimales ya que la unidad
basica es la décima de pulgada (2,54mm). El conector que figura en el esquema eléctrico no se
corresponde con un componente real, sino que utilizaremos como tal una tira de pines estandar
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cuya separacién es de una décima de pulgada (la misma separacién que encontramos entre las
patillas del circuito integrado).

Reglas de diseno.

En este curso vamos a trabajar con unas reglas de diseiio alejadas de lo que marcaria la normativa
de calculo de anchura de pistas y separacion entre ellas. El motivo es facilitar, llegado el caso, la
fabricacidn de la placa resultante con medios modestos. Mds adelante especificaremos con detalle
estas reglas; en este momento nos vamos a limitar a detallar sus consecuencias a la hora de
resolver la placa de forma manual:

O No se deberd pasar mas de 3 pistas en paralelo por debajo del integrado (siendo
recomendable pasar sélo 2).

0 No pasar pistas entre las patillas del integrado.

0 No pasar mas de 4 pistas por debajo de una resistencia (siendo recomendable pasar sélo
3).

0 No pasar mas de 1 pista por debajo de un condensador.

0 No pasar pistas entre las patillas de los potenciémetros.

Realizacion practica.

En esta practica se pretende resolver la placa de circuito impreso correspondiente al generador de
formas de onda propuesto. Para ello se ha de buscar un recorrido valido para todas las conexiones
del circuito incluyendo el conector.

Restricciones y recomendaciones adicionales:

O Seva a realizar el rutado a una sola cara por lo que los recorridos (las pistas) no se pueden
cruzar.

O El conector se debe situar en la periferia de la placa. No mds de una pista (en paralelo)
puede pasar entre él y el borde de la placa.

0 No se permite alterar el orden de las patillas del conector.

0 Es recomendable situar el componente mas complejo (el circuito integrado) en el centro
del disefo.

En primera instancia, se realizard un borrador sin escala de la placa resultante. Una vez resuelto el
problema, se dibujaran las huellas de los componentes y las pistas que les unen a tamafio real.
Para facilitar esta labor, en la pagina siguiente se dispone de una cuadricula pulgametrada sobre la
qgue es mas facil ubicar los elementos. Recordar que, al ser las distancias entre patillas de los
componentes multiplos de una décima de pulgada, siempre van a poder ser ubicadas en
intersecciones de la cuadricula.



Practica 1: Disefio manual.




& ] UNIVERSIDAD
] DE BURGOS

Practica 1: Disefio manual.

Entrega.
Tras la realizacién de esta practica se entregard un informe que estarad integrado por dos
elementos principales, ademas de todos los comentarios que se considere oportuno anadir:

0 Borrador fuera de escala de la resolucién del circuito.
0 Disefio a tamafio real de la placa incluyendo las huellas de los componentes y las pistas
que los unen.

En ambos casos son validas las imagenes escaneadas de los disefios.
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Practica 2 : Captura de esquemas.
El proceso de disefio de la placa comienza habitualmente por la introduccién del esquema
eléctrico del circuito en mediante una aplicacidén de captura de esquemas.

Existen numerosos paquetes de software que permiten la edicién de esquemas, el disefio de la
placa de circuito impreso e incluso la simulacién. Algunos de ellos son gratuitos y otros son de
pago. Cuestiones importantes que se deben tener en cuenta a la hora de elegir uno de ellos es
que, ademas de proporcionarnos la funcionalidad adecuada, disponga de suficientes librerias de
componentes y su uso esté ampliamente extendido para que nos facilite el intercambio de
ficheros con otros usuarios. Estas cuestiones habitualmente las cumplen los programas de pago.
En este curso nos hemos decantado por el uso de Eagle, aplicacién propietaria de Cadsoft y por lo
tanto de pago. Este programa dispone de una licencia “freeware” para uso educacional que no
plantea ninguna limitacion para los objetivos de este curso.

El presente documento hace referencia a la version 7.2.0 de Eagle. Pido disculpas por adelantado
si el equipo de Cadsoft es mds rapido en la actualizacidn de Eagle que yo en la de este manual de
practicas.

Instalacion y configuracion de Eagle
Es posible obtener la versidn mas reciente de Eagle en la web de descargas del propietario:
http://www.cadsoftusa.com/download-eagle/

El proceso de instalacidn es trivial, por lo que no nos vamos a detener en él, simplemente recalcar
que, al final del mismo, se nos interrogara sobre el tipo de licencia, a lo que podremos responder
que queremos ejecutarlo como “freeware”.

Antes de comenzar puede ser interesante ajustar la ubicacidn por defecto de los proyectos que
vayamos a crear. Para ello podemos entrar en el menu de opciones “Options” y ajustarlo como se
muestra en la Figura 2.1.
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Figura 2.1 Figura 2.2

A continuacion crearemos un nuevo proyecto a través del menu de fichero “File” en la opcidn
“New”, como se muestra en la Figura 2.2.


http://www.cadsoftusa.com/download-eagle/
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Podremos asignarle un nombre al proyecto y, posteriormente, mediante un click derecho sobre el
propio proyecto crear un nuevo esquema eléctrico: “New” -> “Schematic”. En ese momento se nos
abrird la ventana de trabajo para que podamos introducir el esquema eléctrico del circuito.

Creacion de un esquema eléctrico.
La creacién de un esquema eléctrico lleva asociadas varias tareas:

0 Localizacion de los componentes en las librerias.
0 Ajuste de las propiedades de los componentes: huella, nombre, valor, etc.
0 Cableado.

Comenzaremos por el componente mds complejo de nuestro disefio: el amplificador operacional.
A través del menu de edicion “Edit” o mediante el icono de acceso rapido como se ve en la Figura
2.3, podemos activar la funcion de afiadir un componente: “Add”.
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Nuestro amplificador se encuentra en la libreria “linear”, en la que podemos encontrarlo con su
nombre: LM324. No obstante, existen dos opciones bajo esta denominacidn, las cuales
corresponden con otros tantos posibles encapsulados: uno para montaje superficial y otro apara
insercion. El nuestro sera este ultimo, denominado “DIL14”.
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Para incorporar el componente al esquema debemos hacer click en “OK”. Es importante recordar
esto porque si hacemos click en la opcion “Drop”, lo que conseguiremos es eliminar la libreria

completa. Si nos ha ocurrido esto, a través del menu “Library” —> “Use”, podemos volver a

incorporarla.

A partir de ahi, cada vez que hagamos click en la hoja de trabajo nos va a aparecer una copia del
amplificador operacional. En nuestro circuito pretendemos incorporar 4 amplificadores
operacionales, que son exactamente los que se encuentran integrados en el LM324 de manera
que con 4 clicks los tendremos todos en pantalla. Luego pulsaremos “Esc” para dejar de incorporar
dispositivos. Todos ellos han de tener la referencia “IC1”, lo que indicaria que pertenecen al
circuito integrado n2 1. Se distinguirdan entre si por las letras: A, B, C, D. Mediante la opcién
“Move” del menu de edicidn o su icono de acceso rapido, como se puede ver en la Figura 2.4,
deberemos ubicar los 4 amplificadores en sus posiciones relativas finales, para respetar el orden
de patillas establecido en nuestro circuito.

Fie Edt Drem View Tooh Libvery Optons  Window  Hdp

GRSE (mo)lil BEAGEA0 ~~ 05 @ = - o4
(i MR
eats 8 x| [Barn i [

b

CR+MECL. hEFEEm,

POIATD)A ITNF

&

Figura 2.4

Los amplificadores operacionales no aparecen con su imagen definitiva aun. Podemos apreciar
que, respecto al esquema de la practica anterior, los amplificadores B, C y D aparecen con sus
entradas invertidas. También vemos que ninguno de ellos dispone de los terminales de
alimentacién. Todas estas cuestiones y otras que afectardn a otros componentes encuentran
solucidn en el menu contextual que aparece al hacer click derecho sobre un componente y que
podemos ver en la Figura 2.5.

10
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Figura 2.5

Gracias a las operaciones vistas hasta el momento podemos llevar a cabo las operaciones que van
a ser necesarias sobre los componentes que vamos a ir incorporando. Veamos ahora cémo
localizar el resto de componentes. La Tabla 2-1 nos muestra en qué libreria y con qué referencia
encontraremos cada uno.

COMPONENTE LIBRERIA REFERENCIA
Conector con-Istb MAO05-1
Resistencia resistor / R-US_ R-US_0207/10
Condensador resistor / C-EU C-EU050-025X075
Potenciéometro pot / TRIM_EU- TRIM_EU-CA6H
Simbolo alimentacion +15V supply2 +15V
Simbolo alimentaciéon -15V supply2 -15V
Simbolo GND supply2 GND

Tabla 2-1

Una vez ubicados todos los componentes y ajustados sus nombres y valores, podemos proceder a
realizar las uniones eléctricas entre ellos. Utilizaremos dos herramientas disponibles en la
aplicacion: “wire” y “junction”. Las vemos resaltadas en amarillo en la Figura 2.6.
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Figura 2.6

Finalmente, mediante la herramienta de edicidon de texto, accesible a través del icono con una “T”,
podemos insertar texto libre. Podemos utilizarla para indicar las salidas correspondientes a las

sefales triangular y cuadrada.

Realizacion practica.

En esta practica se debera reconstruir el esquema eléctrico del circuito que se presentd en la
Practica 1, reproduciéndolo de la manera mas fiel posible, no solo manteniendo sus caracteristicas
eléctricas, sino también su apariencia estética con el fin de practicar con las diferentes
herramientas que se han mostrado hasta ahora.

Entrega.

La practica concluird con la entrega del fichero correspondiente al esquema eléctrico del circuito
junto con una hoja resumen en la que se reflejen los pasos realizados asi como las posibles
dificultades encontradas y cuantas sugerencias se consideren oportunas.
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Practica 3 : Disefio manual por ordenador.

Este titulo, en apariencia contradictorio, viene a indicar que en esta practica vamos a utilizar el
ordenador como mera herramienta de dibujo. El disefiador va a tomar todas las decisiones acerca
de la ubicacion de los componentes y el trazado de las pistas y las va a materializar sobre la hoja
de trabajo.

Para ello se partira del esquema eléctrico introducido en la Practica 2.

Disefio de placa a partir del esquema eléctrico.

Una vez finalizado el esquema eléctrico, podemos pasar directamente a la aplicacion de disefio de
placas de circuito impreso mediante el icono “Generate/switch to board”. En la Figura 3.1 lo
podemos ver resaltado junto con la nueva ventana que se abre.
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Figura 3.1

Los componentes se encuentran inicialmente fuera de la zona de trabajo. Su traslado a su
ubicacién definitiva es muy sencillo ya que simplemente haciendo click sobre un componente, éste
se desplazara con el ratén hasta que un nuevo click lo deposite en el lugar de la placa elegido
como se muestra en la Figura 3.2. Un click derecho lo rotara antes de depositarlo.
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Es importante asegurarse de que el estado de rotacion del componente corresponde con el que
tenia en el esquema eléctrico. De otro modo, el disefio de la placa nos parecera imposible de
reproducir.

Cuando tengamos los componentes ubicados podremos pasar a trazar las pistas. En esta practica
vamos a proceder de forma manual. Para ello disponemos de dos iconos, como podemos ver en la
Figura 3.3. Uno para trazar pistas y otro para borrarlas si el resultado no es el que esperabamos.
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i encuentra activa la capa inferior de la placa “Bottom”. Es
s precisamente por esta cara por la que pretendemos trazar las
a pistas en una tecnologia de insercion como es el caso, por lo que
- 7 no seria necesario modificar esta seleccion. Se podria no obstante
J’; = modificar el color de esta capa si lo consideramos oportuno.
(Y8
aT
19=
Figura 3.3

Antes de comenzar a trazar las pistas debemos ajustar su anchura. Este tipo de consideraciones se
encuentran reguladas por normativa (IPC 2221) y tienen su fundamento en aspectos eléctricos,
como es la densidad de corriente que los conductores pueden soportar manteniendo su
temperatura en unos determinados margenes. En nuestro caso vamos a proceder a
sobredimensionar considerablemente el disefio ya que la escasa corriente que va a circular por
nuestros conductores nos llevaria a trazar pistas extremadamente delgadas; muy dificiles de
fabricar con éxito si no se dispone de los medios adecuados.

En la Figura 3.4 observamos que, habiendo seleccionado la herramienta para trazar pistas,
podemos ajustar la anchura “Width” de las mismas individualmente. Si lo hacemos antes de
trazarlas, las tendremos directamente en el tamafio deseado.
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En nuestro diseio vamos a trabajar con pistas de 0.032 pulgadas (unos 0.8mm).

|
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Figura 3.4

En la Figura 3.4 podemos ver otras opciones asociadas al trazado de las pistas que nos pueden ser
de utilidad. Eagle nos proporciona diversos estilos para trazar cambios de direccién en el recorrido
de las pistas. Es recomendable, de cara al comportamiento electromagnético de la placa, que
estos giros se realicen formando angulos superiores a 909.

Modificacion de los pads.

“Pad” es un término en inglés que en este dmbito hace referencia a cada uno de los elementos
que forman parte de la huella de un componente. En tecnologia de insercién estan formados por
un taladro pasante y la corona de cobre que se mantiene a su alrededor.

Los componentes llevan asociado un encapsulado estandar que define todos estos parametros de
forma correcta, sin embargo, en funcién sobre todo de los medios da fabricacién, puede ser
necesario hacer modificaciones. En nuestro caso vamos a tratar de agrandar la corona de cobre
para que el proceso de taladrado manual no lo elimine totalmente.

Existen diversas formas de abordar esta cuestion en Eagle; nos decantaremos por crear unas
nuevas huellas para cada componente en las que aparezcan estos cambios. Desde el panel de
control de Eagle abriremos la libreria en la que esta la huella que vamos a modificar. Podemos
verlo en la Figura 3.5.

€ Control Panel - E:\data\Tecnologia Sistemas Electronicos\manual de pré:t\caS\aagle\Pla_i SNRCL X
View Options Window Help
New » jtion
* Open V€ Project ,
Open recent projects 3
5S4 Schematic...
Save all B Board..
Close project n Lireme
Exit Alg+X @ caMlob..
% placa.brd ULP.
= placa.dru EAGLI B Sipt
56 placa.sch -
B et
« . r
Figura 3.5

Mas que modificar un encapsulado existente, es recomendable crear uno nuevo como se ve en la
Figura 3.6.
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El nuevo encapsulado aparecerd vacio. Para no tener que crearlo desde el principio, es
recomendable editar el encapsulado de partida y copiarlo integro en el nuevo. El proceso no es
muy intuitivo, por lo que lo explicaremos sobre la Figura 3.7.
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Figura 3.7

|g| La herramienta “group” nos permitird
seleccionar el  encapsulado completo
rodedndolo con el raton manteniendo pulsado
el click izdo.

|@| Seleccionamos la herramienta “copy”. Un
click derecho nos abre el menu en el que
seleccionamos la opcion “Copy: Group”.

En este momento tenemos el encapsulado en
el portapapeles. Si abrimos el nuevo
encapsulado, podremos copiarlo completo en
él.

Es importante prestar atencion a la posicion
relativa del nuevo encapsulado respecto al
origen de coordenadas en la hoja. Para poder
manipularlo posteriormente con facilidad en la
placa, el componente debe estar sobre el
origen.

Mediante la herramienta “Change” se puede modificar tanto el didmetro exterior de los pads

(“Diameter”) como el taladro interior (“Drill”). En la Figura 3.8 se pueden ver estas opciones. Una

vez seleccionada una, se hard click individualmente sobre cada pad para hacer efectivo el cambio.
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En nuestro diseio vamos a ajustar todos los taladros interiores a 0.019”, mientras que los

diadmetros exteriores de: resistencias, condensadores y potenciometros los ajustaremos a 0.1”.

Este diametro nos permite taladrar con cierta comodidad, pero no podemos mantenerlo en el
circuito integrado y el conector porque provocaria un solapamiento de los pads. Para ellos

ajustaremos a 0.076”.

Una vez guardada la nueva huella, ésta debera ser asociada al componente para que aparezca en

la lista de encapsulados disponibles para él. Dentro de la misma pantalla de edicidn de libreria, se

debera seleccionar el componente y asignarle la nueva huella como se ve en la Figura 3.9.
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En el menu “Library” recurriremos a la opcién “Update” para actualizar la libreria. Posteriormente,
desde el esquema eléctrico recurriremos a la herramienta “Change” -> “Package” para, tras
seleccionar el componente, asociarle la nueva huella. Cuando regresemos al disefio de placa, la
huella se habra modificado.

Cuadro resumen de los pasos necesarios para crear una huella modificada:

Paso |Descripcion Observaciones

1 Abrir libreria Abrir la libreria en la que esta la huella a modificar

2 Crear nueva huella [En el icono “Package”, seleccionar “New” y darle nombre a la nueva
huella.

3 Copiar huella En el icono “Package”, seleccionar la huella que se va a modificar.

Mediante la herramienta “Group” rodear la huella completa vy
ejecutar “Copy:Group”.

Volver a la nueva huella y ejecurar el icono “Paste”.

4 Modificar pads En el icono “Package” seleccionar “Drill”, ajustar el valor previsto y
hacer click sobre cada pad.

En el icono “Package” seleccionar “Diameter” y proceder igual.

5 Anadir huella En el icono “Device” seleccionar el componente y afnadir el nuevo
encapsulado (“New”).

Conectar los terminales copiando las conexiones del encapsulado
original (“Copy from”).

6 Actualizar libreria | Salvar los cambios y actualizar libreria: “Library -> Update”.
7 Modificar huella En el disefio de placa, en el icono “Change”, seleccionar “Package”
Tabla 3-I

Realizacion practica.

El objetivo de esta practica es la transposicién del esquema realizado en la Practica 1 a la
herramienta de disefio de placa de Eagle, de manera que el ordenador nos sirva como
herramienta de dibujo para obtener una imagen de la placa de calidad suficiente para ser
fabricada con medios modestos.

A partir del esquema eléctrico, se creara la placa. Se partira de la lista de huellas y conexiones
eléctricas configuradas. Se modificaran las huellas para cumplir con los tamafios de pads
especificados en esta practica y se trazardn las pistas ajustando su anchura a 0.8 mm.

Se pretende que el resultado final presente unas dimensiones adecuadas, por lo que habra que
procurar que los componentes se encuentren lo mas préximos entre si dejando espacio
I6gicamente para trazar las pistas que se tengan previstas entre ellos.

Entrega.
La practica concluira con la entrega del fichero correspondiente disefio de la placa. Se adjuntara
un informe en el que se describa el trabajo realizado y las dificultades encontradas.
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Practica 4 : Disefio manual por ordenador II.

En la Practica 3 se resolvieron los principales problemas relacionados con el disefio manual de la
placa en el ordenador. Sin embargo la placa no se encuentra aun en situacién de poder ser
fabricada. Antes va a ser necesario realizar algunos ajustes y remates que vamos a ver en esta
practica.

Se van a realizar las siguientes tareas:

0 Ajuste del borde exterior de la placa.
Insercidn de un texto identificativo.
Colocacién de marcas de referencia exteriores.
Inclusién de agujeros de montaje.

O O O O

Impresion del cliché de fabricacion.

Ajuste del borde exterior de la placa.

El borde exterior de la placa aparece por defecto como una delgada linea de color negro. A su
izquierda se situan los componentes y sus conexiones cuando abrimos la placa por primera vez
desde la aplicacion de captura del esquema eléctrico. Posteriormente movemos los componentes
a su interior y trabajamos ya en este ambito.

El borde exterior sirve como frontera para el autorrutado de la placa y es, para cualquier otra
operacion su limite natural. Por este motivo va a ser necesario modificar sus dimensiones e incluso
su forma. Se trata de trabajar en un espacio suficiente pero no excesivo.

Si se dispone de alguna restriccion de tamafio para la placa, convendra ajustar de entrada el
tamanio del borde exterior para no superarlo en ningin caso. Si, como es nuestro caso, no es asi,
podemos ajustarlo una vez realizada la ubicacién de los componentes y el trazado de las pistas. En
el primer caso, seria necesario utilizar la herramienta “Dimension” " que veremos mas adelante
para poder ajustar las dimensiones exactas.

El proceso consiste en seleccionar la herramienta “Move” y hacer click sobre cada una de las lineas
del borde exterior para ajustar su posicion individualmente como se puede ver en la Figura 4.1.
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/ e Se pueden mover las lineas completas o girarlas respecto a uno de
/ H sus extremos. El objetivo es acercar el borde a los componentes y
i . . ~ .
® pistas del diseio sin hacer contacto con ellos.

Figura 4.1

Para nuestro proceso de fabricacidn va a ser conveniente que el borde exterior forme parte del
cliché que utilizaremos como mascara para la insolacion de una placa sensibilizada. Por este
motivo es también recomendable que tenga un grosor significativo. Vamos a ajustar sus lineas a
un grosor equivalente al de una pista del circuito impreso, esto es 0.8 mm. Para ello, en la
herramienta “Change” seleccionaremos “Width” -> 0.8128. Luego haremos click sobre las lineas
del borde para modificar su grosor una a una.

Insercion de un texto identificativo.

Mediante la herramienta “Text” T podemos introducir texto libre en nuestro disefio. No tiene
efecto en el comportamiento del circuito pero si el objetivo es que aparezca en la placa en cobre
como es el caso, hay que cuidar que no tenga contacto con ningln otro elemento de la misma. Si
nos encontramos trabajando sobre la cara “Bottom” el texto que introduzcamos en la ventana que
se abre al pulsar sobre la herramienta “Text” aparecera invertido ya que la cara “Bottom” es la
cara inferior de la placa y por lo tanto se observa desde abajo. Es correcto que aparezca asi.
Podemos verlo en la Figura 4.2.

' ' R
»
oixsl,
Figura 4.2

Ademas de identificar la placa, el texto tiene una segunda funcién. El disefio que estamos
realizando lo vamos a imprimir en un soporte transparente para que nos sirva de cliché en el
proceso fotografico de transferencia. Este cliché debe ser colocado en la posicidn correcta en la
maquina insoladora, de lo contrario el resultado seria inservible. Al ser transparente es facil
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equivocarse de lado. El texto seria el Unico elemento inequivoco en este caso. Desde nuestra
posicién debemos seguir leyéndolo al revés si estd destinado a aparecer en la cara inferior.

Colocacion de marcas de referencia exteriores.

A diferencia del borde exterior y el texto, que tienen utilidad tanto en un proceso de fabricacion
manual como industrial, las marcas de referencia exteriores son de utilidad tan solo en procesos
manuales. El problema que han de resolver es la alineacidn entre la placa y el cliché dentro de la
maquina insoladora. Cuando colocamos la placa sobre el cliché dejamos de verlo por lo que no es
dificil que nos queden finalmente desalineados. El resultado es que conseguiremos una placa que
funcionard perfectamente pero estard “torcida”, lo cual dista mucho de dar una sensacién de
calidad. Las marcas exteriores han de estar alineadas con el borde exterior de la placa y sobresalir
de ella para seguir siendo visibles en la insoladora. En la Figura 4.3 podemos ver cémo seria el
resultado en una de las esquinas. Es conveniente hacer lo mismo en las cuatro esquinas del borde

exterior.
" L =
4
oxsl,
Figura 4.3

El grosor y longitud de las marcas no son criticos; no van a ser reproducidos en cobre al quedar
fuera de las dimensiones de la placa.

La forma de realizar estas marcas es sencilla. Recurriremos a la herramienta “Wire” [ y las
dibujaremos como si estuviéramos afadiendo una pista de forma libre, es decir, sin conexién
eléctrica previa. No importa que tengan contacto con el borde exterior, aunque no deben tenerlo
con ningun elemento interior del disefio.

Inclusion de agujeros de montaje.

Es habitual y recomendable prever el ensamblado posterior en el equipo de la placa que estamos a
punto de fabricar. En muchos casos su fijacion se realiza mediante tornilleria convencional. Para
que ello sea posible habra que reservar espacio dentro de las dimensiones de la placa para realizar
los taladros en los que se insertaran los tornillos. Existen dos formas de introducir estos agujeros
de montaje en nuestro disefio. La herramienta propiamente dicha para ello es la que proporciona
el icono “Hole” y que nos permite definir un agujero de montaje alli donde hagamos click en
nuestra placa. Posteriormente podemos utilizar la herramienta “Change” y hacer click derecho en
el agujero para modificar su tamafio. Otra opcién es emplear la herramienta “Circle” [©, que nos
permite dibujar un circulo en cualquier parte del disefio. La Figura 4.4 nos muestra el resultado de
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afiadir un agujero de montaje. Junto a ella, la Figura 4.5 nos muestra un circulo que realizaria la
misma funcién.

oIxsl,

O omemO

Figura 4.4 Figura 4.5

Para una fabricacion manual, cualquiera de las dos opciones es igualmente valida, sin embargo, en
un proceso industrial el resultado es totalmente distinto. El agujero de montaje declarado
mediante la herramienta “Hole” se convertird en un taladro no metalizado a través del cual
podremos fijar nuestro tornillo. El objeto declarado mediante la herramienta “Circle” se convertira
en un circulo de cobre sin taladro alguno.

Impresion del cliché de fabricacion.

Para poder fabricar la placa por procedimientos manuales necesitamos disponer de su imagen a
tamanfio real en un soporte transparente en el que aparezca un diseiio totalmente opaco. Esto lo
podemos conseguir imprimiendo directamente sobre soporte transparente o fotocopiando en
acetato una impresidn previa en papel. En cualquier caso el resultado debe quedar totalmente
limpio (cualquier suciedad va a salir en cobre) y con un trazo sélido. Es recomendable incluso que,
para suplir la resolucién finita de las impresoras, se superpongan dos clichés correctamente
pegados entre si y perfectamente alineados.

La herramienta “Layer settings” nos da acceso a la ventana “Display” como se muestra en la Figura
4.6. En ella podemos seleccionar las capas que queremos que sean visibles para su impresion. En
nuestro caso seleccionaremos las capas: “Bottom” (pistas, texto, marcas exteriores y circulos),
“Pads” y “Dimension” (borde exterior y agujero de montaje).

e
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Figura 4.6
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Para obtener el disefio impreso simplemente debemos utilizar la opcién “File” -> “Print” como en

cualquier otra aplicacidon. La ventana que se muestra en la Figura 4.7 refleja los ajustes

recomendados que bdsicamente se reducen a marcar las opciones “Black” y “Solid”.

B Print &J
printer:  [Print to Fie (DF) -
Output fie: de pra pdf [ ]
Paper: IM(meZQ?mm, 8.3x11.7 inch) x) [

Onentaton: [Portrait )

Alignment: [ Center -]
Area: [Fut -] @

V] preview

Options Scale
[ mirror. Scale factor: 1

[ Rotate Page liit: )
[ Upside down

[ Black

[ soid

[¥] caption

Caibrate Border
X 1 Left  z.2mm Right  3.1mm
LE Top  3.mm Bottom  3.2mm

ox | [ cenesl

Figura 4.7

Realizacion practica.
En esta practica vamos a finalizar el disefio de la placa destinada a su fabricacion de forma manual

en el laboratorio. Para ello vamos a incluir los diferentes elementos descritos en esta practica:

0 Ajustar el borde exterior de la placa al contorno final de la misma. El grosor de la linea serd
equivalente al de una pista al igual que su distancia a los elementos del circuito mas
préoximos.

0 Insertar un texto identificativo con un grosor y dimensiones adecuados para que sobreviva
al ataque del acido que eliminara el cobre sobrante. Entre 1.5 y 2.0 mm puede ser un
tamafio adecuado.

0 Colocar las marcas de referencia exteriores.

0 Incluir los agujeros de montaje ya sea utilizando la herramienta “Hole” o la herramienta
“Circle”. Ajustar su didmetro a 3mm.

0 Seleccionar las capas para la impresion del conjunto e imprimir la placa. La imprimiremos
a pdf para facilitar su entrega.

Entrega.

La practica concluird con la entrega del fichero pdf correspondiente disefio final de la placa. Se

adjuntara un informe en el que se describa el trabajo realizado y las dificultades encontradas.
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Practica 5 : Diseiio automatico.

Hasta ahora nos hemos basado en las decisiones tomadas en la Practica 1 para llevar a cabo la
ubicacién de componentes y el rutado de la placa. Este trabajo lo hemos dirigido a una fabricacion
manual mediante un proceso fotografico de transferencia y atacado quimico.

En esta practica vamos a reorientar ambos aspectos, tanto la toma de decisiones como el proceso
de fabricacién previsto. En cuanto a la toma de decisiones vamos a mantener aquellas que se
refieren a la distribucion de los componentes, ya que Eagle no realiza un posicionado automatico.
El trazado de las pistas si se hara de forma automatica. Respecto al proceso de fabricacidon, vamos
a asumir ya una fabricacién industrial, en la que el resultado de nuestro disefio lo enviaremos a un
fabricante de placas que nos devolverd el circuito impreso encargado. Esta cuestion va a influir en
las reglas de disefio de la placa, tanto a nivel cuantitativo en los valores que damos al tamafio de
los elementos, como a la forma en la que establecemos estas reglas.

Como se ha comentado en la Practica 1, la anchura y separacion de las pistas se normaliza en
funcién de parametros eléctricos. Por otra parte, los fabricantes nos van a plantear unos tamafios
minimos de los elementos a fabricar. De esta manera, nuestras reglas deberdn atender a ambos
requerimientos.

El punto de partida en esta practica va a ser el esquema eléctrico creado en la Practica 2. A partir
de él vamos a realizar de nuevo el disefio de la placa utilizando técnicas, herramientas y reglas
distintas.

Reglas de diseiio.

La primera cuestiéon que debemos abordar en el establecimiento de las reglas de disefio es el
tamanio de los pad. En la Préctica 3 hemos visto cémo definir nuevas huellas para los componentes
en las que los pads satisfagan las restricciones de nuestro proceso de fabricacidon. Asumiendo que
cualquier fabricante va a ser capaz de trabajar con las huellas que los componentes seleccionados
en nuestro disefio incluyen por defecto, vamos a devolvérselas antes de hacer ninguna otra cosa.
Para ello basta con volver a seleccionar el encapsulado original en la aplicacién de captura de
esquemas.

El resto de reglas de disefo se van a ajustar ya en la aplicacion de disefio de PCB. Para ello iremos
al menu “Edit” -> “Design rules”, que nos dard acceso a la ventana que se muestra en la Figura 5.1.
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6 Design Rules (default *) ==

Fle | Layers | Clearance | Distance | Sizes | Resting | Shapes | Supply | Masis | Misc |

EAGLE Design Rules

The defaut Design Rules have been set to cover a wide range of applications. Your particular design may have different requirements, so please make the
necessary adjustments and save your customized design rules under a new name.

| [Cconcs ][ appir ]

Figura 5.1

En la ventana encontramos varias pestafas. Vamos a trabajar con las siguientes:
O Llayers: para ajustar las caras de rutado.
0 Clearance: para ajustar la distancia entre pistas.
O Sizes: para ajustar la anchura de las pistas.
O Restring: para ajustar el tamafo de los pads.

Capas de rutado.
Por defecto Eagle va a ajustar dos capas de rutado: “Top” y “Bottom”. La pestaia “Layers” nos

permite eliminar una de las dos para poder rutar a una cara.

Design Rules (default ?) |

Layers | Clearance | Distance | Szes | Restrng | Shapes | Supply | Masks | Misc |

1 e Copper Isolation
100
1.5mm
15 0.035mm
Totsl: 1.535mm
18

Setwp (1%16)

Layers are combined through either core or prepregmaterial, a*b combines layers 2and Swith a core, while a-+b does the same with prepreg.
Buried and through vias are defined by writing (. ..3.

Blind vias are defined by writing [t- - - k], which defines a blind via from top to layer £and from bottom to layer &,

Bxample: [2:1+((2%3)+(4*16) )] is a multilayer setup with two cores, combining layers 2f3 and 4/18, respectively, with buried vias going through both
cores. The cores are combined through a prepreq and buried vias are produced through the resuiting stack, Finally layer 1is added, with blind vias going from
layer 1t0 2,

| [ cancel ] [ apaly

Figura 5.2

Si ajustamos el grosor de la capa de cobre en la cara “Top” (Nr. 1) a cero como se ve en la Figura
5.2, la cara “Bottom” sera la que quede para realizar el rutado. El grosor de la capa de cobre
adquiere el valor por defecto de 0.035 mm, es decir, 35 micras, que es el grosor ciertamente mas

comun.
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Distancias.
Dado que los valores derivados del tipo de sefales que van a circular por nuestra placa son muy

bajos y que no tenemos un fabricante concreto al que dirigirnos, vamos a tratar de establecer
unos valores razonables para anchura de pistas y para distancias entre ellas. Tomaremos por
convenio el valor de 0.4 mm (aprox. 16 mils) para ambas.

B Design Rules (default 9 =)
[Fe | Layers | Cleaance | Distance | Sizes | Restring | Shapes | Supply | Masks | Misc |
Different Signals
Wire
wire | 16mil Pad
Pad  1amil 16mil Via
va  16mi t6mil 16mil
Same Signals
Smd Pad via
Smd  16mil 16mil 16mil
Minimum Clearance between objects in signal layers.
The Same Signals. check between Smd'and ¥ does not apply to Mcro Vs,
The Same Signals check does not apply if an Smdfand SmdPadtare in the same package.
Setting the values for the Same Signals chedks to 0 dissbles the respective check.
| [ ] [ ooy ]
\
Figura 5.3

En la Figura 5.3 hemos sustituido todos los ajustes, cuyo valor por defecto era de 8 mils, por 16
mils. Muchos de ellos no tienen aplicacidn en nuestro caso particular no obstante.

Anchura de las pistas.
Siguiendo el mismo criterio que hemos empleado para definir la distancia entre pistas,

ajustaremos su anchura a 16mils como se ve en la Figura 5.4.

B Design Rules (default ) (===

Fie | Layers | Clearance | Distance | Sizes | Restring | shapes | supply | Mesks | msc |

Minimum Width 16mil
Minimum Dril 24mil

Min. Micro Via 9.99mm

Min. Blind Viz Ratio 0.5

Minimum Sizes of objects in signal layers and of cril holes.
Minimum Width and Minimum Drill may be overnritten by larger values in the et diasses for spedific signals.

HMin. Micro Via applies to bindvias that are exactly one Layer deep. Typical values are in the range 50...100 micron, The value has to be smaller than
HMinimum Drll; othervise (e.g. with the default value of 9.99mm) there are no micro vias defined.

Min. Blind Via Ratio defines the minimum dril diameter o'a bind via must have if it goes through a layer of thickness & Board manufacturers usually give this
“aspectratio”in the form 1:0.5, where 0.5 would be the value that has to be entered here.

ok | [ cancel ]|

Figura 5.4

Tamaiio de los pads.
En la Figura 5.5 vemos el contenido de la pestafia en la que se define el tamafio de los pads. Este
se determina como porcentaje del didametro de su taladro interior. El ajuste por defecto sefiala un
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25% del mismo con unos limites inferior y superior de 10 y 20 mils respectivamente. Estos valores
resultan apropiados para esta parte de nuestro trabajo, por lo que los dejaremos inalterados.

B Design Rules (default *) %)
[ Fie | Layers | Cearance | Distance | Szes | Resting | Snapes | Supply | Masks | Misc |
Min % Max Diameter
Pads Top [ 10mi 25 20md
tner  1omi 2 2omi O
Battom  10mil 25 20md
Vias Outer  &mi 25 20mi
Ioner  gmi 25 20mi a
Micro Vias Quter  4mi 5 20mi
Ioner  4mi 25 20mi
Restrings for pads and vias are defined in percent of the drl diameter (imited by Min and Max). If the diameter of an actual pad or via would resuitina
larger restring, that value wil be used in the outer layers.
If the Diameter option is checked the actual pad of via diameter vl be taken into account in the inner layers, too.
Micro Vias are Alindvias that are exactly one layer deep and have a dril diameter that is smaller than the Minimum Drill value defined under Szes (which
may be overritten by a larger Drill value in the Aef dizsses).
|
|
cancel | [ apiy |
Figura 5.5

Preparacion para el rutado.

Como se senald en la Practica 4, el autorrutado va a necesitar de la definiciéon del borde exterior
de la placa para delimitar el drea permitida para el rutado de las pistas de circuito impreso. En
muchas ocasiones el destino final del circuito condiciona sus dimensiones, las cuales a su vez
determinarian el borde exterior. En nuestro caso no es asi, por lo que plantearemos un borde
exterior que proporcione cierta amplitud para el rutado teniendo en cuenta que posteriormente lo
podriamos reducir.

Ya se ha explicado cémo operar con el borde exterior, por lo que no se va a insistir en este
momento. Igualmente se ha explicado como situar los agujeros de montaje, que también es
recomendable que se posicionen de forma previa al rutado.

Las marcas exteriores que se mencionaban también en la Prdctica 4 no van a ser necesarias, ni en
este momento ni posteriormente, ya que la fabricacién industrial no las requiere.

Autorrutado.

Una vez realizados los ajustes de las reglas de disefio y definida el area de rutado podemos
proceder a ordenar el rutado. Para ello recurriremos al icono que nos da acceso al autorouter y
gue nos abre la ventana que vemos en la Figura 5.6.
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2= | B8 Autorouter Main Setup

=)

Preferred Directions

The Autorouter is routing the board with different
sets of parameters depending on the Effort
setting, if Routing Grid or Preferred Directions are
set to Auto. Multiplecore processars are

supported.
4 Effort __Luw -
[¥] Auto grid selection
16 Bottom [¥] Variant with TopRouter
Maximum number of running threads 4 B
[contive... | [ select | [ concel |
J
Figura 5.6

Practica 5: Disefio automatico.

En la parte izquierda de la ventana vemos que las
caras de rutado se pueden seleccionar
independientemente de lo que se haya establecido
en la pestana “Layers”.

El autorouter incluye diversas opciones de
configuracion. No es nuestro objetivo entrar en sus
caracteristicas, por lo que vamos a mantener los
ajustes por defecto.

Seleccionaremos la opcién “Continue” y en la ventana que se abre haremos click en “Start”. La

placa quedard rutada de forma completa. En caso contrario, deberemos mover algin componente

para facilitar el trazado de las pistas.

Realizacion practica.
En esta practica se pretende realizar el rutado automatico de la placa de circuito impreso

siguiendo los pasos descritos en los apartados anteriores. El objetivo es el rutado completo de la

placa a una y a dos caras. Obviamente, el rutado a dos caras va a exigir volver a habilitar la cara

“Top” en la pestafia “Layers” de la Figura 5.2. También va a ser necesario habilitar esta cara en la

ventana de configuracién del autorouter.

Antes de realizar un nuevo rutado sera necesario deshacer el anterior. Esto se puede hacer de una

forma muy rapida si, después de seleccionar la herramienta de borrado de pistas “Ripup” <,

hacemos click en la herramienta “Go” £ que se activa en la parte superior.

Entrega.

La practica concluye con la entrega de un informe en el que aparezcan las imagenes de los dos

rutados solicitados junto con los pasos realizados vy las dificultades encontradas.
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Practica 6 : Fabricacion industrial.

Hasta ahora hemos diferenciado dos formas de trabajar con nuestro disefio condicionadas por la
tecnologia de fabricacidon. Cuando vamos a fabricar con los medios de que disponemos en el
laboratorio debemos definir unas reglas de disefio claramente sobredimensionadas para facilitar el
proceso artesanal. No es esta la forma habitual de trabajar del profesional del disefio electrdnico.
Lo usual es que la placa disefiada sea enviada a un fabricante para que la someta a un proceso
industrial. En tal caso, las reglas de disefio seran mas realistas dentro de las posibilidades
tecnoldgicas del fabricante. Por este motivo, en la Practica 5 hemos definido unas reglas mas
relajadas.

En caso de que se requiera trabajar con reglas muy estrictas, lo cual generalmente equivale a
elementos y distancias muy pequenos, habrd que comprobar las restricciones tecnoldgicas del
fabricante.

En esta practica vamos a ver cdmo preparar una placa para ser enviada a fabrica y cdmo realizar
este proceso.

Preparacion de la placa.

En la Practica 5 hemos visto cdmo obtener una placa terminada mediante un proceso de rutado
automatico. Hemos establecido unas reglas de disefio que van a poder ser admitidas sin dificultad
por cualquier fabricante. Partiremos de ese resultado en esta practica.

En cuanto a si utilizar el rutado a una cara o a dos, no vamos a tomar una decision definitiva. Los
fabricantes de PCB nos van a dar un presupuesto que varia principalmente en funcién del nimero
de capas y el tamafio de la placa, ademds de otros aspectos. La placa rutada a doble cara se puede
hacer mas pequeiia que la rutada a una sola cara, pero no siempre esto nos va a permitir entrar en
un segmento de menor coste. Dejaremos que el alumno elija el fabricante y decida cual de los dos
disefios le proporciona un coste menor.

Envio de la placa.

Los fabricantes nos van a demandar una informacién completa sobre la placa. Las aplicaciones de
desarrollo como Eagle generan esa informacidon de manera automatica. Los formatos son diversos,
pero la inmensa mayoria de los fabricantes nos van pedir lo siguiente:

0 Un fichero Gerber habitualmente en formato RS-274X en el que se describen las diferentes
capas que forman la placa. En él se van a encontrar los movimientos necesarios para el
trazado de las pistas, los pads, la serigrafia, etc.

0 Un fichero en formato Excellon en el que se detalla la posicién y didametro de los taladros.

En la Figura 6.1 podemos ver la herramienta CAM que nos da acceso a la ventana de configuracion
para seleccionar el tipo de documentacion de salida que queremos generar. En el menu “File”
seleccionaremos “Open -> Job”. Entre los trabajos que nos aparecen por defecto seleccionaremos
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“gerb274x.cam”. Conviene notar que el formato Extended Gerber (RS-274X) aparece referenciado
como dispositivo de salida. Esto es asi por razones histdricas.

@ lEECaQAg «~ Q¢! @) 0. M@l

r N
D 3 CAM Processor - CAEAGLE-7.2.0\cam\gerb274x.cam - EAGLE 7.2.0 Light L |5 ﬁ
File Layer Window Help
Component side ‘ Solder side | Silk screen CMP | Solder stop mask CMP Solder stop mask SOL |
Jab Style Nr = Layer ol
Section Component side [C] Mirrar 1 Top
16 Bottom
Prompt O Rotate 17 Pads
[ upside down 18 Vias -
Output 19 Unrouted r
) pos. Coord 20 Dimension
Device (GERBER_RS274X %) || O] cudglet 31 tPlace I
22 bPlace
Optimize 23 tOrigins |
= [¥] Fill pads 24 bOrigins
File YeM.cmp 35 tNames
26 bNames
Offset 27 tValues
—— 28 bValues
% |onch 29 tStop
¥ Oinch 30 bStop
31 tCream
32 bCream
22 tFinich T
Process Job ] [Prucess&ctim] [ Description I [ Add ] | Del
Figura 6.1

Veremos que en la parte derecha de la ventana aparecen preseleccionadas varias capas del disefio
para incluir en el Gerber. Podemos modificar la seleccion, pero normalmente serd la adecuada.
Eso si, la capa “Top” debera estar o no seleccionada en funcién de que el rutado sea a doble cara o
a simple cara. Pulsaremos “Proces Job”.

Para generar el fichero Excellon de taladros, el procedimiento es el mismo sustituyendo el trabajo
anterior por “excellon.cam”.

Después de procesar ambos trabajos, nos encontraremos con 5 ficheros generados por el trabajo
Gerber y 2 generados por el trabajo Excellon como podemos ver en la Tabla 6-I.

Fichero Generado por-... Contenido
%N.cmp Gerber Cara de componentes
%N.sol Gerber Cara de soldadura
%N.plc Gerber Serigrafia de la cara de componentes
%N.stc Gerber Médscara de soldadura de la cara de componentes
%N.sts Gerber M4dscara de soldadura de la cara de soldadura
%N.drd Excellon Fichero de taladros
%N.dri Excellon Fichero de informacién para el fabricante
Tabla 6-I

Comprobacion de los resultados.

Antes de enviar los ficheros a fabrica conviene verificarlos. Para ello podemos utilizar un editor de
Gerber. Existen editores gratuitos e incluso on-line, por ejemplo:

http://www.gerber-viewer.com/
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La Tabla 6-1l muestra un ejemplo de lo que podemos observar en la edicion de estos ficheros.

o Q
Q Q
o
(=] [e]
(=] [s]
pggpess ° D
)
o @eeEsE® , o
[oan) [0
@ @ T
0 & 2 1 28 o Wit garbarviewer. corm
%N.cmp
© O
L] — o o
o R3
= o o
ci
{:ms}l E — c O [s]
[T (S
[ -
= s e (P geegees °
| .
0 o EEEELEEES o %
’_P,m? - [00] [ ]
R | P L J @ @ @
N I T i N
%N.plc %N.stc
O
(o]
Q o
o o O
o] o]
@] O
o O
BEBEBES © %
]
o peseses , I
. @ @
%N.sts %N.drd
Tabla 6-11

Si estas imdgenes se ajustan a lo previsto, los ficheros ya se pueden enviar al fabricante.

Realizacion practica.

El objetivo de esta practica es el envio a fabrica de la placa disefiada, ya sea en su versién de
simple cara o a doble cara. El alumno elegird un fabricante de acuerdo con su criterio. A modo de

sugerencia se proponen los siguientes:

http://imall.iteadstudio.com/open-pcb/pcb-prototyping.html

http://www.seeedstudio.com/service/index.php?r=pcb
http://www.pcbya.com/es/product.php
https://www.olimex.com/PCB/
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Entrega.
Como resultado de esta practica se entregaran los ficheros generados, la placa fabricada y un

informe detallando los pasos realizados y las dificultades encontradas. En este informe se incluira
la referencia de la empresa elegida para fabricar la placa y una valoracion del servicio recibido en
términos de:

0 Calidad del resultado (de 1 a 5).

O Rapidez de la entrega (de 1 a 5).

0 Precio (abusivo, excesivo, razonable, barato, muy barato).

(0]

Sistema de pago.
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Practica 7 : Seleccion de componentes.

Una vez fabricada la placa de circuito impreso, nos quedan algunas tareas para completar el
trabajo. En lo que se refiere a su utilizacion, debemos todavia realizar la seleccion de los
componentes y su soldadura. La seleccidn de componentes no es una labor trivial. Nosotros la
hemos situado cerca del final del proceso y, dada la simplicidad de nuestro disefio, no hay
problema en hacerlo asi. Sin embargo, en la mayoria de los casos, la seleccién y el disefio avanzan
en paralelo. Es necesario conocer qué componentes se van a utilizar para poder seleccionar su
encapsulado y disponer de la huella correcta en el disefio de la placa. Habra que conocer si vamos
a trabajar con encapsulados de insercién o de montaje superficial. En muchas ocasiones el tipo de
encapsulado que nosotros preferimos no estd disponible en el mercado o no en el plazo que
necesitamos.

Lista de componentes.

La seleccidon de componentes comienza, obviamente, por el conocimiento de qué componentes
necesitamos. Dado que hemos decidido relegar esta tarea para el final del proceso, tenemos
también la ventaja de poder disponer de las herramientas que nos proporciona Eagle para facilitar
esta tarea. Concretamente, la herramienta de edicién de esquemas nos permite obtener una lista
de los componentes empleados en nuestro disefio. Para generarla iremos al menu “File” ->
“Export” -> “BOM”". Se nos abrira la ventana que vemos en la Figura 7.1.

§6 Eagle: Bill OF Material [
curent variant [~
aty | Value Device Tachice Parts Description MF  MPN  OCFARNELL  OC +
1 MAD5-1 MAD5-1 v PIN HEADER unknown unk
1 100k R-US0207/10 0207710 RS RESISTOR, American symbol
1 100n C-EUDS0-025X075 CO50-025X075 C1 CAPACITOR, Eurapean symbol
1 22n C-EUDS0-025X075 CO50-025X075 C2 CAPACITOR, Eurapean symbol E
1 27 R-US0207/10 0207710 R RESISTOR, American symbol
1 5k6 R-US 0207710 0207710 R4 RESISTOR, American symbol
1 LMIZN  LMIZN DILLd 1a 0P AMP
2 10k TRIM_EU-CAGH  CAGH POTL, POT2 POTENTIOMETER
3 I 10k R-US 0207/10 _ 0207/10 RZ.R3,A5 _ RESISTOR, American symbol @
< [ 3
List type Output format.
@ Parts © Text
@ Values ® csv
List attributes © HML
[ wew | [ save.. |[ bep ][ close Version 1,10
Figura 7.1

La opcion por defecto es la de lista de componentes “Parts”, pero cambiaremos la seleccién a
“Values” que nos va a ser mas Util. Posteriormente guardamos el resultado en un fichero de texto
mediante el botén “Save”. ES recomendable guardarlo en formato CSV para facilitar su posterior
tratamiento como hoja de célculo. La lista de atributos activada por defecto podemos mantenerla
o ignorarla; nosotros incluiremos nuestros propios atributos después.

Seleccion de componentes en el mercado.
Una vez que disponemos de la lista de componentes necesarios para nuestra placa, vamos a ver la
forma de obtenerlos en el mercado. Empezaremos por crear una hoja de calculo a partir de la lista
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anterior. Podemos abrir directamente el fichero de salida .csv por ejemplo en Microsoft Excell. Le
vamos a afnadir una serie de columnas de atributos:

0 Referencia de distribuidor 1 (RS-Online).
O Referencia de distribuidor 2 (Farnell).
0 Precio de cada uno.

Farnell y RS son dos distribuidores a escala global que nos podran proporcionar la gran mayoria de
los componentes que busquemos. Vamos a tratar de localizar los componentes de nuestro disefio
en ambos y anotar las referencias en la hoja de calculo. Anotaremos el precio mas bajo que en
negrita. Veremos el caso de nuestra resistencia de 10k a modo de ejemplo.

En primer lugar entraremos en la web de Farnell (www.farnel.com) y seleccionaremos nuestro

pais. En la ventana de busqueda introduciremos “resistencia”. El motor de busqueda nos planteara
multiples sugerencias. Nos quedaremos con la opcidon asociada a resistencias de taladros pasantes.
Esta seleccién nos dara acceso a una pagina en la que podemos precisar, como se ve en la Figura
7.2, para llegar al modelo mas adecuado aplicando diversos filtros:

= Fabricante

= Valor nominal

= Potencia

= Tipo de resistencia

= Etc
Rango de Producto Resistencia Potencia Nominal Tolerancia de Resistencia Tipo de Resistencia Ter

- (443) - Ochm (6) - -(2) - -(3) - - (18) -

BI TECHNOLOGIES - BPC Series (25) 0.001chm (2) 50mw (7) + 0.005 % (2) E 2010 [Métrica 5025] (4)

BI TECHNOLOGIES - BPR Series (5) 0.0020hm (2) 100mW (19) + 0.005% (10) 4525 [Métrica 11464] (1)

BI TECHNOLOGIES - MHP100 Series (7) 0.004chm (1) 125mw (723) + 0.01% (50) Axial Leaded (5331)

BI TECHNOLOGIES - MHP140 Series (1) o 0.005chm (15) « 200mw (10) « + 0.02% (7) = Cargade Axialmente (7207) +
Seleccionar un min. Iz‘ Seleccionar un min Iz‘ Seleccionar un min. Iz‘ Seleccionar un min. Iz‘ Seleccionar un min. Iz‘ Sele
Seleccionar un méx. Iz‘ Seleccionar un max. Iz‘ Seleccionar un méx. Iz‘ Seleccionar un max. Iz‘ Seleccionar un méx. Iz‘ Sele

4 I,

Figura 7.2

Obviamente, nuestro primer criterio es el valor de la resistencia, 10k. Si seleccionamos “Mostrar
resultados” veremos que éste no es un gran filtro ya que la mayoria de fabricantes van a
proporcionar este valor tan comuin en diversos valores de potencia nominal, diferentes
tecnologias, etc.

Nuestro siguiente criterio deberia ser la potencia. En nuestro trabajo hasta ahora no nos hemos
ocupado de determinar valores de corrientes, tensiones y potencias, ya que en esta asignatura no
tratamos esas cuestiones. En este momento deberemos hacer uso de la informacién de disefio del
circuito o de su simulacion. Para centrarnos en nuestra misién afiadiremos simplemente que la
corriente que va a circular por nuestros componentes va a ser muy pequeiia, al tiempo que hemos
seleccionado un encapsulado que nos permite insertar resistencias desde la mas baja potencia
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hasta resistencias de pelicula de aproximadamente 1W. Descartaremos por el momento las de
menos de 250mW y de mas de 500mW.

En lo que se refiere a la tolerancia, nuestro disefio no es muy exigente, por lo que vamos a aplicar
un filtro por tipo de resistencia en su lugar. Seleccionaremos resistencias de pelicula de carbdn
(“Carbon flim”) que son de bajo coste y proporcionan unas prestaciones adecuadas a nuestro uso.

Los resultados proporcionados por el motor de busqueda pueden variar a lo largo del tiempo pero
seguramente este filtro ya ha centrado mucho o totalmente la busqueda. Farnell nos ofrece, en el
momento en que se ha redactado este documento, resistencias de pelicula de carbdén de 10k,
500mW, 350V y tolerancia del 5%, a un coste unitario de 0,006 €. El cddigo Farnell de este
producto es “1127905".

El proceso de trabajo en la web de RS-Online (http://es.rs-online.com) es muy similar al caso de

Farnell, por lo que nos ahorraremos los detalles. En este caso la busqueda nos da otro valor de
resistencia distinto al pedido, pero hay que tener en cuenta que las resistencias se fabrican en
series que abarcan un amplio rango de valores. El precio unitario que nos proporciona este
distribuidor es de 0,025 € para un pedido de 10 unidades. Esto es muy superior al anterior, pero lo
anotaremos igualmente. Su referencia es 707-8091.

Con estos datos, nuestra hoja de célculo va quedando como se ve en la Figura 7.3.

Qty Value  Device Package Parts Description Farnell Price RS-Online  Price
1 MAO5-1 MAD5-1 Sv1 PIN HEADER
1 100k R-US_0207/10 0207/10 RG6 RESISTOR, American symbaol
1 100n C-EU050-025X075 CO050-025X07 C1 CAPACITOR, European symbol
3 10k R-US_0207/10 0207/10 R2,R3,R5  RESISTOR, American symbol 1127905 0,006 707-8091 0,025
2 10k TRIM_EU-CAGH CABH POTL, POT2 POTENTIOMETER
122n C-EU050-025X075 CO50-025X07 C2 CAPACITOR, European symbol
1 2k7 R-US_0207/10 0207/10 R1 RESISTOR, American symbol
1 5k6 R-US_0207/10 0207/10 R4 RESISTOR, American symbaol
1 LM324N LM324N DIL14 IC1 OP AMP
Total Total
Figura 7.3

De cara a la decision final sobre donde lanzar nuestro pedido hay que tener en cuenta que, para
una placa tan econdmica como la nuestra, no conviene mezclar distribuidores ya que los costes de
envio van a ser superiores a los de los componentes encargados. Lo adecuado en este caso sera
decantarse por el distribuidor cuya suma de precios sea inferior, aunque siempre teniendo en
cuenta que los costes de envio, que seran diferentes en cada caso, pueden decantar la balanza del
lado opuesto.

Dejaremos al alumno la tarea de completar la hoja de calculo, no sin antes proporcionar algunas
directrices:

0 Abrir la hoja de caracteristicas del componente para asegurarse de que el encapsulado y la
huella coinciden con los que hemos previsto en nuestro disefo. Esto es especialmente
importante en el caso de los potenciometros, los condensadores y el conector. Si no son
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los adecuados, va a ser imposible soldarlos a la placa. No perderlo de vista tampoco en el
caso del circuito integrado que ha de proporcionar el encapsulado de insercién DIP.

0 En el caso de los condensadores vigilar especialmente que sean sin polaridad.

0 Aunque la huella coincida, prestar atencidn a las caracteristicas del encapsulado. No es
imprescindible que corresponda exactamente con el que tenemos previsto, pero debe
tener unas dimensiones que hagan que no colisione con los componentes préximos.

Realizacion practica.

En esta practica el objetivo es realizar la seleccién de componentes a nivel comercial, determinar
su coste individual y el coste del conjunto. Se han proporcionado las referencias de dos
distribuidores; el alumno puede acudir a ellos o elegir otros, indicando en tal caso cudles son los
elegidos. Al menos se deben proporcionar dos precios para cada componente.

Entrega.

En esta practica se entregara un informe en el que se incluya la hoja de célculo (embebida o en
fichero aparte) en la que se detallan los componentes de la placa y sus caracteristicas en formato
analogo al de la Figura 7.3, asi como un relato de los pasos realizados y aspectos mds relevantes a

sefialar.
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Practica 8 : Documentacion del proyecto.

Para finalizar correctamente nuestro trabajo, lo adecuado es generar una buena documentacion
que sirva a otras personas para continuarlo o retomarlo. Hay que tener en cuenta que, al igual que
en esta asignatura nos hemos desentendido de todo lo que tiene que ver con calculo y simulacién
del circuito propuesto, un eventual departamento de compras por ejemplo, se va a desentender
de nuestro trabajo de disefio y se va a limitar a encargar aquello que le hemos especificado.
Igualmente nos puede suceder que el disefio tenga que ser retomado en el futuro para realizar
alguna modificacidn. Por todo ello, la documentacion debe ser completa, clara y ordenada.

En esta practica vamos a ver qué documentacién debemos proporcionar y cdmo generarla.

Ficheros de diseiio.

A estas alturas de nuestro trabajo, en la carpeta de proyecto habran aparecido multitud de
ficheros. ¢Cuales de ellos son realmente necesarios para almacenar y recuperar nuestro proyecto?
Son 3:

O eagle.epf: almacena informacidn de caracter general sobre el proyecto.
0 sch: es el fichero en el que se encuentra el esquema eléctrico.
O brd: almacena el disefio de la placa de circuito impreso.

Si queremos crear un nuevo proyecto a partir del anterior, deberemos copiar los ficheros .sch y
.brd en la carpeta del nuevo proyecto vacio una vez creado éste. Cerraremos el proyecto y al
volver a abrirlo nos preguntara si queremos incorporar el archivo .sch. Aceptaremos esta opcion.
Al crear el nuevo proyecto se habrd generado automaticamente un fichero eagle.epf en su
carpeta.

Dcoumentacion.

En la Practica 7 hemos visto uno de los apartados de la documentacién del proyecto mas
relevantes: la lista de materiales. Esta lista se ha de incluir en la documentacidn del proyecto, ya
sea directamente o con la informacidn afiadida que hayamos considerado relevante. En nuestro
caso estamos almacenado referencias de proveedores y precios.

Otro aspecto que contribuye a una mejor documentacién del proyecto es la posibilidad de
acotarlo. Mediante la herramienta de disefio de PCB podemos insertar las medidas reales de los
elementos que consideremos oportunos. Habitualmente nos interesarad acotar las dimensiones
externas de la placa. Mediante la herramienta “Dimension” que ya veiamos en la Practica 4 al
referirnos al borde exterior de la placa, podemos afadir las cotas que consideremos oportunas. En
la Figura 8.1 se puede ver la placa acotada en sus dimensiones, vertical y horizontal.
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54.62

54.61

Figura 8.1

Conviene notar que las dimensiones se asocian a una capa determinada. En la Figura 8.1, se ha
utilizado la cara “Top”. En caso de acotar la placa por la cara “Bottom”, las cotas se verian
invertidas.

A través del menu “File -> Export -> Image” accedemos a la ventana “Export Image” que vemos en
la Figura 8.2.

rIl!l Export Image ﬁ
File Browse...
[ clipboard [ Monechrome
T b = i Podemos incrementar o decrementar la resolucion,
Image Size [393 % 372 pixel guardarla en blanco y negro (“monochrome”), o copiar
- la imagen al portapapeles (“Clipboard”).
[ Ok ] [ Cancel

Figura 8.2

Para nuestro trabajo, tanto la opcién de salvarla a fichero, como la de copia en el portapapeles
pueden ser validas. La Figura 8.1 ha sido obtenida mediante la seleccién de opciones por defecto,
incrementando la resolucién a 600 dpi.

Eagle proporciona también una herramienta para obtener datos estadisticos sobre el disefio que

,

hemos llevado a cabo. Podemos acceder a ella a través del menud “Tools -> Statistics”, que nos da
acceso a la ventana que vemos en la Figura 8.3.
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8 Eagle: Statistic of E:/data/Tecnologia Sistemas Electronicos/manual de practicas/eagle/Placa/placaauto.brd &J
BOARD | LAYER | cLAsSS @igna) | wiotH [ powgon [ smp | pap [ via | priumole | Eement | mask [ RecTcmole [ TEXT |
Summary Minor values
max. Board length (Layer 20)
¥ = 55.09 158 wire(s) ind. Arc(s) 0.1524 - Text width
¥ =55.41 a Polygon(s)
ot used-5MD X
Outline contour = 217.78 0 SMD(s) top
- 0 SMD(g) bottom nAofused-SMDY
used layers 2 0 SMD(s) total 0.4064 - Wire width 0.8128 -Pad dril
0.2540 - Pad Restring I i
1jé-|§c?tmm 4L PAD(s) nof used- Polygon wire width = e.s ng tnner.
g EEI ot used- Arc width nof - Via dril
ole
£ used- Via Restring Inner.
========”====|======= 0.,4064 - Cirde width fo. 13 Restring Inner.
43 Drills total
0.2540 - Pad Restring (¥ < 0.3000 3.0000 -Hole dril
a tCream
f used'- Rectangle X
a bCream nofused - YVia Restring e ectangle
T —— £ used - Rectangle ¥
Routing Info: 0.2050 - Clearance "1 < 0,3000 e ectangis
12 Signal(z)
41 PAD/SMD total not used - 1solate Polygon
41 PAD/SMD on Signal
Packages used area: 1 raf-empty-/~ Values
~ 503,26 mm2 {0,050 dm?)
All Units = mm Version 1.3.9
Figura 8.3

La informaciéon que se proporciona en las diferentes pestafias de la Figura 8.3 puede ser
almacenada en un fichero de texto con extensidn .rep, mediante la opcion “Save report”. La
utilidad de estos datos estadisticos esta abierta a las necesidades del usuario. Permite realizar
valoraciones comparativas entre diferentes soluciones, examinar la complejidad de la placa,
establecer su densidad de componentes, etc.

Archivos de fabricacion.

En la practica vimos cdmo generar la informacidn necesaria para poder enviar la placa a fabrica.
Los archivos que se han de incluir aparecen relacionados en la Tabla 6-I, por lo que no vamos a
insistir mas en este apartado.

Realizacion practica.

En esta practica se pretende generar toda la documentacidn relevante asociada al proyecto de
disefo que se ha llevado a cabo en las practicas anteriores. Como hemos visto, esta tarea incluye
tres tipos de aspectos:

0 Archivos de disefio.
0 Documentacion.
0 Ficheros de fabricacion.

Algunos de estos elementos se han generado en practicas anteriores, por lo que solamente sera
necesario recopilarlos. Otros habra que generarlos en este momento.
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Entrega.
Al finalizar la practica se hard entrega de un archivo comprimido en el que se incluyan tres

carpetas:

0 Carpeta “Disefo”: en la que se encuentren los archivos de disefio de la placa generados en
las practicas anteriores: esquema, disefio manual, disefio automatico a simple cara y

disefio automatico a doble cara.
0 Carpeta “Documentacidon”: en la que se encuentre la hoja de calculo de componentes, las

imagenes de los distintos disefios de placa: manual y automatico a simple y doble cara en

formato .png, el informe de datos estadisticos.
0 Carpeta “Fabricaciéon”: en la que se encuentren los ficheros que permiten el envio a

fabrica de la placa.
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